
 

 

 

 

 

APPLICATION COMMON OPERATING 
ENVIRONMENT (APPCOE) 

 

TRAINING GUIDE 

 

Version 1.0 – March 12, 2013 

 
 
 
 
 
 
 
 
 
 

Copyright (c) 2013 

MapuSoft Technologies 

1301 Azalea Road 

Mobile, AL 36693  

www.mapusoft.com 
 

 

 

 

 



  AppCOE Training Guide 
  (For Private Circulation Only)   

        2 

Copyright 
 
 
The information contained herein is subject to change without notice. The materials located 
on the Mapusoft. (”MapuSoft”) web site are protected by copyright, trademark and other 
forms of proprietary rights and are owned or controlled by MapuSoft or the party credited as 
the provider of the information.  
 
MapuSoft retains all copyrights and other property rights in all text, graphic images, and 
software owned by MapuSoft and hereby authorizes you to electronically copy documents 
published herein solely for the purpose of reviewing the information.  
 
You may not alter any files in this document for advertisement, or print the information 
contained herein, without prior written permission from MapuSoft. 
 
MapuSoft assumes no responsibility for errors or omissions in this publication or other 
documents which are referenced by or linked to this publication. This publication could 
include technical or other inaccuracies, and not all products or services referenced herein are 
available in all areas. MapuSoft assumes no responsibility to you or any third party for the 
consequences of an error or omissions. The information on this web site is periodically 
updated and may change without notice. 
 
This product includes the software with the following trademarks: 
MS-DOS is a trademark of Microsoft Corporation. 
UNIX is a trademark of X/Open. 
IBM PC is a trademark of International Business Machines, Inc. 
Nucleus PLUS and Nucleus NET are registered trademarks of Mentor Graphics 
Corporation. 
Linux is a registered trademark of Linus Torvald. 
VxWorks and pSOS are registered trademarks of Wind River Systems. 
 
For additional assistance, please contact us at: 
MapuSoft Technologies 
1301 Azalea Road 
Mobile, Alabama 36693 
251.665.0280  
251.660.0288 FAX 
support@mapusoft.com 
info@mapusoft.com  
http://www.mapusoft.com  
 
Copyright (©) 2013, All Rights Reserved 

 



  AppCOE Training Guide 
  (For Private Circulation Only)   

        3 

Table of Contents 
 
1. General Introduction ....................................................... 4 

1.1 What is AppCOE ? ............................................................................ 4 
1.2 Installing AppCOE ............................................................................ 5 
1.3 Installing license key ........................................................................ 5 
1.4 Introduction to AppCOE IDE ............................................................ 7 

 

2.  Develop C/C++ Projects ................................................... 8 

2.1 Creating an AppCOE C/C++ project .................................................. 8 
2.2 Configuring Project Settings ............................................................ 15 
2.3 Importing existing projects/source files into Workspace .................. 19 
2.3 Building, Running and Debugging Projects. .................................... 23 

 

3.  Target Code Generation ................................................. 28 

3.1 Optimize Target Code Generation .................................................... 28 
3.2 Full Package Library Generator ....................................................... 40 

 

4.  Legacy Porting Tool ....................................................... 43 

4.1 Importing VxWorks workbench C/C++ Project. ............................... 43 
4.2 Importing Legacy C/C++ Project. .................................................... 47 

 

  
 



  AppCOE Training Guide 
  (For Private Circulation Only)   

        4 

1. General Introduction 

1.1 What is AppCOE ? 

AppCOE (Application Common Operating Environment) is a framework of common 
architecture that promotes interoperability and cross-platform capabilities among systems and 
devices. It is built on the powerful open source Eclipse-based framework and integrates all of 
MapuSoft’s tools: OS Changer, Cross-OS Development Platform, Cross-OS Hypervisor, 
Linux OK, OS Simulator, App/Platform Profiler, OS Version UpKit and Ada-C/C++ 
Changer. Embedded C, C++ and Ada applications can be standardized on AppCOE to allow 
the applications to interoperate and run seamlessly on a single platform. 
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1.2 Installing AppCOE 

Downloading AppCOE 

You can download a free demo or trial version as per your requirement from our website. 

After downloading the installer file proceed as follows. 

Download URL: http://www.mapusoft.com/downloads/ 

 

Installing in Windows 

1. Double click on the installer file. 

2. Installer will ask for a directory to install AppCOE release. Browse to the 

directory or provide a directory name when prompted 

3. Once installed, reboot the computer. AppCOE will not run properly without re-

boot 

4. Now Run  appcoe.exe in AppCOE < installdir > or launch the AppCOE 

application from the windows desktop menu: Programs>AppCOE 

 
In order to get additional functionalities and upgrade your AppCOE to full version, ask for 

license from Mapusoft Support. To install the license key proceed as below. 

 

1.3 Installing license key 

Launch AppCOE. Click on “ ” icon. Browse to the path where the license key is stored on 

your local drive and then select install. AppCOE will process the key and will keep a copy of 

the license file inside the <installdir/license> folder 
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1.4 Introduction to AppCOE IDE 
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2. Develop C/C++ Projects 

2.1 Creating an AppCOE C/C++ project 

1. In AppCOE workbench, goto File > New > AppCOE C/C++ Project. 

 

2. On AppCOE C/C++ Project Wizard window, type a project name and give a location 

next to Project Name text box.  
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3. Under Project Types, expand the Executable menu(You can also create library project 

of makefile project just the same way we do in eclipse), here we are creating an 

Executable Template Project. 

a) Now Choose the type of project you want to create. 

b) The difference between Empty and Template project is just that in Empty 

project you need to write your code from scratch, i.e. from “main”. But in 

Template Project AppCOE does everything for you. So it will put up all the 

required files for a demo application that is ready to build and run. Further if 

you want to have your own application running, you can just customize 

Template Project source code as per your needs.  
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4. On Basic Settings window, define the basic properties of your project and click Next.  

 

4.1 The Application Name should be within 1 to 8 characters. 

4.2 The Application Prefix is the path for all your resources. For e.x. in medical 
applications you may have prefix as “/cabinet-A/Shelf-1/Box-5…” and so 
on. By default it is set to root. 
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5. On Select Configurations window, select the platforms and configurations for 
deployment and click Next 
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6. On Select APIs window, select the required AppCOE development APIs and click 
Finish 

Please Note: If your want to include support for multiple interfaces then you can 

accordingly check the desired checkboxes. 

 

Now an AppCOE template project will be created as below.
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You can view the following template files for your project on the left pane of the window. 

The description of these files is as follows: 

 

 _os_init_<os name>.c  or  _os_init_<os name>_host.c – This is entry function for the 

native operating system (in this case it is windows). This is where you should put any of 

your operating system specific code. For instance, if you want to add a signal handler on 

<os name> host, you could do it here before calling OS_Main() in the respective 

“_os_init_<os name>.c” function. When optimizing, you will need to write an equivalent 

function for your target operating system. 

 

 os_application_start.c– This function is the first OS agnostic function and should be the 

start point for the application development. 
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 os_library_init.c– This function initializes the required Interface products and creates the 

entry threads for each product. 

 

 os_main.c– This function initializes the OS Abstractor Interface layer and calls 

OS_Application_Wait_For_End which will suspend until OS_Application_Free or 

OS_Delete_Process is called. It also spawns the first OS Independents thread which is the 

true entry point for OS Abstractor Interface. 

 

The application code starts in the os_library_init.c file, the user defined entry function and 

name of the application for OS Abstractor Interface can be specified in: 

#define OS_ABSTRACTOR_BASE_ENTRY_FUNCTION  

#define OS_APPLICATION_START_TASK_NAME 

For ex. in Vxworks interface, the user defined entry function and stack size can be specified 

in: 

#define VXWORKS_ENTRY_FUNCTION 

#define VXWORKS_ENTRY_FUNCTION_STACK_SIZE 

 

Similarly, this is how it works for all the remaining changers/abstractors. 
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2.2 Configuring Project Settings 

 

1. Right click on the respective project and click on properties as shown below 
 

 
 

2. The AppCOE property page will appear as below: 

a. Here you can again add/remove available development API`s as in “6th step of 
Creating an AppCOE C / C++ project” by checking / unchecking the desired 
checkboxes. 

b. In order to view / modify various other settings of the project you can scroll 
between the respective nodes on the left. 
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3. AppCOE uses some flags to automatically compile the required part of code. To view 
these flags goto C/C++ build > Settings and then in the Tool Settings tab goto GCC C 
Compiler > Symbols. 
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4. To view / modify include files or paths goto C/C++ build > Settings and then in the Tool 
Settings tab goto GCC C Compiler > Includes 

a. In the figure below you can see include paths of all the development API`s that 
you included earlier 

b. In order to remove any path select the corresponding path and click on Remove 
button 

 

 

c. In order to add any path, click on Add button, “Add directory path” Dialog box 
will appear. 

d. Enter the appropriate directory path or select it from workspace or directly select 
it from file system. After entering the path click on OK. 
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5. To view / modify the Libraries goto C/C++ build > Settings and then in the Tool 
Settings tab goto GCC C Compiler > Libraries. 

a. In the figure below you will be able to see libraries of all the development API`s 
that you included earlier. 

b. In order to add/remove any library proceed similarly as done in Step 4 above to 
add include paths. 

 

 

 

6. Once all the settings have been done. Click on Apply and then OK. 

 

Please Note: It has been observed that many developers are not able to compile and run their 
projects even after having added the appropriate libraries and include paths.  

 

I. Here one reason may be wrong path, you can edit the include paths, libraries or 

library search paths by using Edit ( ) button, next to remove button. 

 

II. Another situation may be that the paths and libraries are not in the desired 
sequence as they are required during build. So you need to shift the desired library 

or their include paths up/down using  and  buttons next to edit button. 
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2.3 Importing existing projects/source files into Workspace 

 
1. To import Project or source files goto File > Import. 
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2. To Import existing source files, choose File System from the Import window and click 
on Next. 

 

 
 

 

3. In the proceeding enter the required fields as required and click on Finish. 
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4. To Import existing project, choose Existing Projects into Workspace from the Import 
window and click on Next. 

a. In the proceeding window enter the required fields and click on Finish. The 
selected project will be imported into the workspace. 
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Only valid Eclipse project 
accepted.

Project Folder

To import from
archive file

Check this to copy 
the whole project into 
AppCOE workspace.

(Prefered when you don’t 
want to disturb original 

project files.)

 
 

 

 

Please Note: While importing please make sure that the you are selecting a valid C/C++ file 
or a proper project with “.project “file. Otherwise AppCOE won`t be able to import any other 
invalid file. 



  AppCOE Training Guide 
  (For Private Circulation Only)   

        23 

2.3 Building, Running and Debugging Projects. 

 

Building Projects 
 

1. Once all the settings have been done, we have to build and “exe”. For this just select your 
project and Goto Project > Build Project. 

a. The Console window will show the progress during build operation. 

 
 

2. If there is some problem in the settings or some compiler error, the build will be stopped 
automatically. The console will report the same along with the error due to which the 
build has been stopped. 

3. If no problem is encountered, the build will end successfully and a binary file (.exe file) 
will be generated. The console will show the acknowledgment of the same. 
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Running Projects 

To run a built project, select the project Goto Run > Run or click on  button. The 
project will start running and the output will be displayed into the Console Window. 
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Debugging the project 
To run the application in debugging mode, select the respective project and Goto Run > 
Debug As > AppCOE Local C/C++ Application or click on  button.. 

 

a. A “Confirm Perspective Switch” dialog Box appears. Click “Yes” to open the 
debug perspective.  

 

 
 

b. The debug perspective will open as below 
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3. Target Code Generation 

 

3.1 Optimize Target Code Generation 

1. To migrate your current source code to different OS, select the project and Goto Tools > 

Optimized Target Code Generator or click on  button. 
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2. The “Optimized Target Code Generator” window will appear. Enter the appropriate 
data into the required fields and press Next. 
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3. A new wizard for Profiler settings will appear. Define your profiler data specifications in 
the Profiler Configuration Tab. 
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4. On Platform API Profiling tab, select the check box to enable your appropriate 

Interface API Profiling 
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5. On Application Functions Profiling tab, you can also perform profiling for your specific 
APIs. Once done click on Next. 
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6. On API Optimization tab, you can select either to generate Full API Library Interface or 
Optimized API interface. 

 
In API Optimization, you can select the API‘s which needs to be a standard function or a 

macro function and move the selected API using the double arrow button as shown below. 
Macro functions will execute faster but will increase the memory footprint of the 
application. Once done click on Next. 
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7. Next you are directed to Task Configuration Wizard as below: 

 

Configure the following below settings as per your requirements. 
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8. Once you are done, Click on Finish to Generate the Target Code. After generation of 
Code, a Generation Verification window will appear acknowledging the success of code 
generation. Click on done. 
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Now you have obtained code ready to build and run on your target platform.  

Please Note: While doing above exercises if you require much in depth explanation of the 

various attributes and parameters that you are setting in the GUI, then please refer to the 

topic “Optimize Target Code Generation” on Pg 122 in “AppCOE User Manual”.
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3.2 Full Package Library Generator 

1. To generate full library package Goto Tools > Full Library Package Generator. 

 

 
 
2. Then in proceeding window, select the Target OS for which you want to generate full 

library package. 
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3. Then enter the Destination path to save the generated code and click on Finish 
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4. The finally generated files will be saved at the directory entered above.  

 

Also while generating “Optimized Target Code”, you can create “Full API Library 
Interface” as in below image. The difference is that by using “Full Library Package 
Generator” you get whole package to create libraries and develop applications using your 
own IDE. The project can be manually configured and scale by modifying the user 
configuration file. 

 

 While using the feature as highlighted below you will get target specific Package. 
This will include you application; OS Abstractor files along with the Target specific 
Project file to directly import your project into the target Development platform. 
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4. Legacy Porting Tool 

4.1 Importing VxWorks workbench C/C++ Project. 

1. To import a VxWorks workbench C/C++ Project. Click on  button and then Goto 
VxWorks > Import workbench ‘C’ Project. 

 
 

2. Then browse for the workspace directory where the VxWorks Workbench projects are 
present and click on Next. 
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3. Select the appropriate Workbench projects and click Next. 
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4. Enter the “Root Task Prototype” and “Root Task Stack Size (in bytes)” in the 

following window. Then Click OK and then Finish. 

 
 

5. A report will be generated, acknowledging the successful porting and describing certain 
fixes required. Read it and Click on Done. 
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6.  Open you application files and put all VxWorks include files into comments. Also add 
Cross OS include files “os_target.h” and “vxworks_interface.h” as below. Save the file. 

Before

After

 
 

Please Note: Here you may also have to remove or rename your main, since AppCOE will be using 

OS Abstractor main. So if you are doing some stuff in main, then rename that and put it as “Root 

Task Prototype” in step 4. Otherwise if you are just calling another function from main, then just 

remove main and enter the function being called as “Root Task Prototype” in step 4. 

 

7. Now you are ready to build and run your VxWorks workbench project in the AppCOE. 
You can also migrate this code to the other OS, using tools described above. 
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4.2 Importing Legacy C/C++ Project. 

1. To import a Legacy C/C++ code. Click on  button and then Goto “<OS >”  > 
Import workbench ‘C’ Project. 

 

 

 

2. Enter the required entries in the following window and click Finish. Now you are ready 
to build and run you Legacy code. You can also migrate this code to different OS using 
above decribed tools. 



  AppCOE Training Guide 
  (For Private Circulation Only)   

        48 

 
 

 

 

Visit www.mapusoft.com or submit ticket at support@mapusoft.com for further information. 



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


